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Tutorial 1: The Freehand Tools 
In this tutorial you�ll learn how to draw and construct geometric figures using Sketchpad�s freehand 
construction tools. You�ll also learn how to �undo� your actions in a sketch, some basics about labeling 
Sketchpad figures, and how dynamic Sketchpad figures are defined by geometric relationships. 
 

• Choose the Point tool by clicking d

• Mov h

• Pos n

On its most basic level Sketchpad provides electronic versions of 
the tools Euclid used: a tool for creating points, a compass for 
constructing circles, and a straightedge for constructing segments, 
rays, or lines. 

Script Tool 

Label/Text Tool 

Straightedge tools 
(Segment, Line, Ray) 

Object Information Tool 

Compass (Circle) Tool 

Point Tool 

Selection Arrow tools 
(Translate, Dilate, Rotate) 

(The Script tool may not always be visible.) 
 
 an  letting go. 

You�ll see the Point tool is highlighted, meaning you�ve chosen it as your active tool. 
 
e t e pointer into the sketch and click to create several points. 

Note that the last point you created has a bold outline. This shows that the 
point is selected. Selection is an important concept we�ll come back to in a 
later tutorial. 

• Choose the Segment tool (click on it and immediately let go). Then move the pointer into the sketch 
and press and drag (holding the mouse button down) to create a segment. 

You might have used the points you already created in your sketch for the 
segment�s endpoints or you might not have. If you didn�t, Sketchpad supplied the 
endpoints for free! (You don�t need to have points in your sketch already to 
construct segments.) 

• Choose the Selection Arrow tool at the top of the Toolbox. 

This is the tool you�ll come back to most often to select and move objects.  
 
itio  the tip of the arrow over one of the segment�s endpoints, press, and drag the point. Drag the 

other endpoint. Drag the segment itself.   

You should observe that dragging an endpoint changes the segment�s length and direction. If you drag the 
segment itself, you preserve its length and direction. (Notice that the Selection Arrow changes to 
horizontal to indicate that it�s positioned over an object that can be dragged.) 

• Experiment with the Point tool, Segment tool, and Circle tool. Make sure you try dragging all these 
objects and the points that define them to see how they behave. 

If at any time you�re unhappy with what you�ve done, even if it�s something you did many steps ago, you 
can reverse your action as follows: 
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• Click on the word Edit in the menu bar at the top of your screen.  Then click on, the first menu item to 
choose Undo.  The wording of the Undo command describes your last step. If your last step was to 

tchpad�s unlimited U

move, or �translate,� a point, the menu would look like this: 

Ske ndo capability is 

 Choose Undo again and again to undo your last several steps.  The keyboard shortcut for Undo is 

If y ant a blank sketch for a clean start, perform the following steps: 

Double-clicking closes the active window, or you can click once and choose Close from the 

c choose New Sketch. You should now have a nice, new, clean sketch in which 

•  so, choose New Sketch in the File menu to open a new sketch. 

ructed your third side the pointer 

and 
sides of the trian e

 that you can drag this triangle into any shape (acute, right, obtuse, etc.) or size. 

• Choose the Circl o d drag until the pointer is directly 

segment�s endpoints to define the center and radius of your circle. 

• Use the Segmen ter, drag, and release when the 

unique. 
 

•
Ctrl+Z. 

ou ever w

• Double-click the System Menu in the upper left corner of your sketch. 

• Cli

menu that appears. 

k the File menu and 
you can start from scratch. 

If you haven�t already done

• Choose the Segment tool and construct a triangle in your sketch. 

You might have noticed that when you const
�snapped� to the point you were aiming for when you got close to it. If you missed, 
you can always Undo and try again. The snapping behavior makes it easier to hit the 
points you�re trying to use in a construction and with practice, you�ll rarely miss. 

• Choose the Selection Arrow tool and experiment dragging different vertices 
gl . 

Note
Your triangle doesn�t have any constraints at all. It can be any type of triangle and, 
in fact, can represent all triangles. This is the power of Sketchpad�s dynamic figures. 
In the following steps, you�ll construct a more constrained triangle�a special case. 

• Use the Segment tool to construct a segment. 

e t ol. Press on one of the segment�s endpoints an
over the other endpoint. Use the Selection Arrow tool to drag each point to confirm that the segment�s 
endpoints really define the circle. 

You�ve used the 
You might have constructed your circle so that it �just happened to pass through� the 
segment�s endpoint. In that case, a third point defines the radius of the circle, and the 
segment will not stay a radius. If that happens, Undo until the circle�s gone, then 
carefully construct the circle again making sure you start and finish your circle 
construction directly over the segment�s endpoints. 

t tool to construct a second radius. (Start at the cen
pointer is positioned anywhere on the circle.) 
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• Connect the endpoints of these radii to complete a triangle. 

What special kind of triangle is this? How do you know? Use the Selection Arrow tool 
to drag the different vertices of the triangle. Does it always stay isosceles? Note how 
the different points behave differently to change the size and shape of the triangle. 
Which point won�t change the length of the legs of the triangle when you drag it? 
Why? 

• Click on the circumference of the circle with the Selection Arrow tool to select it. (Little black 
squares at top, bottom, left, and right indicate that a circle is selected.) 

• Choose Hide Circle in the Display menu. 

Now drag the vertices of the triangle. Note that even though the circle is hidden, it still 
participates in the geometry of your construction. The hidden circle continues to constrain 
your triangle to be isosceles. 

Everything you construct in Sketchpad is automatically given a label. Objects� labels can be displayed 
individually with the Text tool. (In another tutorial you�ll learn how to display labels automatically using 
Preferences in the Display menu.) 

• Click the hand icon to choose the Text tool. 

 
• Move the hand in your sketch so that the tip of the finger is centered over a point. (The hand will 

reverse color when correctly positioned.) Click the point. 

The point�s label is displayed as an uppercase letter. If it�s a double letter, like AA or AB, that just means 
you�ve been sketching for awhile and have run out of alphabet. Whenever you open 
a new sketch, you start again from A. 

• If the label is in an inconvenient place, you can press the label and drag it somewhere else. 

When the finger is positioned directly over a label, the letter A appears inside the hand. When 
you press on a label, a box appears around it to indicate you are acting on the label. Sketchpad 
won�t let you drag a label too far from its object. To hide the label, click the object (not the 

label) again. 

• Press the Segment tool and hold down the mouse button. 

When you hold down the mouse button, segment, ray, and line icons pop out to 
the right. (You might have noticed this already.) The Segment tool is currently 
chosen in the Toolbox, but if you drag to the right and release, you can 

reconfigure your straightedge to create rays or full lines. 

• Experiment with creating rays and lines in your sketch. 

Rays and lines also are defined by two points, the first where you press the mouse button and the second 
where you release after dragging in the direction desired for the ray or line. As with segments, previously 
constructed points can be used to define rays and lines. 

One thing (among many) that sets Sketchpad apart from graphics programs is that objects you construct 
with Sketchpad are mathematically related by the definitions you give them when you construct them. 
You�ve seen that already in your isosceles triangle. For another example of what this means, follow these 
steps: 
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• Close the sketch you�re currently working in. (Double-click the system menu, or choose Close from 
the File menu.) 

• Open a new sketch. (Choose New Sketch from the File menu). 

• Construct a circle. 

• Now use the Segment tool to construct a segment by pressing somewhere outside the circle, then 
dragging and releasing somewhere on the circle. 

You should have a circle, a segment, two points defining the circle, and the 
two segment endpoints. All six of these objects are related mathematically. 
Moving any one of them will affect some or all of the others. Unlike a 
graphics program, when you construct connected objects in Sketchpad, 
Sketchpad knows you want them to be connected. 

• Experiment more with the freehand tools in the Toolbox. Pay attention to how you construct objects 
so that they�re related to one another. Try some of these freehand constructions. Make sure to 
manipulate them to see how they behave: 

1. A segment and a point on the segment. 

2. A segment with one endpoint on another segment. 

3. Two segments that intersect, and a third that has an endpoint at the intersection. 

4. A ray and a line that always goes through the ray�s control point. (A ray is defined by two points: an 
endpoint and a control point that determines its direction.) 

Help: If you have any questions or problems using Sketchpad, help is as close as the F1 function key on 
your keyboard. Unfortunately, Sketchpad�s full help file is too large to fit on the demonstration disk, so 
this disk contains only an abbreviated sample to let you see how the regular version�s help file works. 

1. Toolbox help: Move the cursor so it�s over the Text tool in the toolbox and press the F1 key on the 
keyboard.  The abbreviated help file appears. (The full help file would show specific information 
about the Text tool, and cross-references leading you to related topics giving full details on all the 
various uses of the Text tool.) Click in your sketch to return to Sketchpad. 

2. Menu help: Click on the Construct menu and pull down so the cursor is over Perpendicular Line. 
Keep the mouse button down and press the F1 key. (The full help file would show specific 
information for the Perpendicular Line construction.) Help is available on all menu items, even if they 
are grayed out. 

3. Dialog help: Similarly, help is available for dialog boxes by pressing the F1 key or by pressing a 
Help button in the dialog itself. 

4. The Help menu: The help menu itself allows you to go directly to a number of help topics. In 
addition, once you�re in the help system, you can search for the specific information you want by 
clicking the Search button and then clicking on the key words you�re interested in. 

Challenge: Construct an equilateral triangle using only the freehand tools. Make sure to drag each vertex 
to confirm it stays equilateral. If you succeed, congratulations, you�ve completed Euclid�s first 
proposition in the Elements. In fact, you�ve done it with a strictly Euclidean, collapsible compass! 
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Tutorial II: Investigating The Centroid of a Triangle 
Because Sketchpad keeps track of mathematical relationships, you can create a single construction with 
certain mathematical definitions, then manipulate that construction and make generalizations for all 
figures that share the same definitions. In this tutorial, you�ll experiment with more Sketchpad features 
while you investigate and make generalizations about the centroid of a triangle. 

• Use the Segment tool to construct a triangle. 

• Use the Selection Arrow tool and drag any vertex. 

By dragging a single vertex, you can create any shape triangle that can exist.  Drag 
any vertex or side to make your triangle appear acute, obtuse, or right. 

• Click one of the sides of the triangle to select it. 

Selection indicators (little black squares) appear on the segment. 
 

• Press Construct in the main menu. 

Note that only two choices (besides Help) are available: Point On 
Object and Point At Midpoint. Lots of other interesting choices are 
�grayed-out,� meaning they�re not things you can do to your selection.  
(Construction Help lists each construction with its prerequisite 
selections.)  If the choice you want isn�t available, you have either too 
little or too much selected. At the moment, you should have only a 
segment selected. If you ever don�t have the desired selection or 
selections, try again by clicking in any blank area of the sketch with the 
Selection Arrow tool (this deselects everything) and carefully selecting 
objects to act upon. 

 

• Choose Point At Midpoint. 

Now wiggle your triangle around again and appreciate the fact that your midpoint stays a midpoint.  To 
speed things up a bit, it would be helpful to construct the remaining two midpoints simultaneously. This 
requires you to select more than on object at a time�a job for the Shift key: 

• Click one segment wit h

Bot how selection indicators. 

 Choose Point At Midpoint from the Construct menu. 

ch selected. Deselect everything by clicking in a 

struct just two of the triangle�s three medians (connect two vertices with 
the midpoints on the opposite sides). 

h t e Selection Arrow, hold down Shift, and click the other segment. 

h segments should s

 
 

•

Again, if the choice isn�t available, you may have too mu
blank area of your sketch with the Selection Arrow tool and try again. You should now have midpoints on 
all three sides of your triangle. 

• Use the Segment tool to con
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• Choose the Point tool or the Selection Arrow and click the intersection of the two medians. 

This constructs the point of intersection. 

• Click this intersection point with the finger of the Text tool (the hand) to display its label. 

When the tip of the finger is positioned directly over an object the hand becomes 
highligh  

• Double-click 

e hand when it�s positioned over a label. Double-clicking 
vokes a dialog box in which you can edit the label. 

 
 

ted (turns black). 
 

the label (not the point) with the Text tool. 

The letter A appears in th
in

 
• Type G for the point�s new label. 

• Click the Style button. 

You�ll be presented with menus for fonts and font sizes 
and check boxes for style attributes. Choose a font, font 

l nk you�ll like.  Click OK (or 

You� : three medians in a triangle 
triangles? 

 

rag the triangle into different types: obtuse, right, acute, scalene, isosceles, equilateral. The medians 
lways intersect in a single point. From one construc ou can generalize for all triangles. This is the 

y with Sketchpad: by distorting a figure and discovering 

dpoints of one of your medians. 

sty e, and size that you thi
press Enter) to dismiss the Style dialog box. Click OK 
again to dismiss the Relabel dialog.  Your centroid should 
now be labeled as such. 

 

• Construct the third median. 

re ready to make your first conjecture
intersect in a single point. But is that true in all 

the 

• Drag any vertex or side of your triangle. 

D
a tion y
wa  you�ll typically arrive at conjectures 
properties that hold for all instances of that figure. 

You may also notice that the centroid divides the medians in an interesting way. You�ll now take some 
measurements to investigate this. 

• Use the Text tool to display the labels of the en
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• Select the labeled vertex and the centroid (hold down Shift to select more than one object). 

 
• Press Measure in the main menu. 

Again, most choices are gray. Like the Construct menu, the Measure menu makes 
choices available based on what makes sense for the selections. With two points 
selected, you can measure the distance between them. It�s a little easier in this case to 
measure distance rather than length. To measure the length from B to Centroid, you 
would have to actually construct a separate segment from B to Centroid, on top of the 
already constructed segment from B to F. 
 
 
 
 

• Choose Distance from the menu. 

The distance is displayed in whatever units are currently chosen under Preferences in the Edit menu�
inches, cm, or pixels. You can change the format of this measurement by double-clicking on it with the 
Text tool (the hand). You can move it like any other object with the Selection Arrow tool. 

• Measure the distance from the centroid to the median�s other endpoint. 

 

Do you notice a relationship between these distances?  To confirm 
your conjecture you can perform a simple calculation with these 
measurements. 
 
 

 

• Choose Calculate in the Measure menu. 

You see a dialog box that looks like a calculator. You can create the 
expression you want to calculate by clicking keys in the keypad at the bottom, 
by choosing items from the three menus in the middle, and by clicking on 
measurements in the sketch. You can also select items from the keypad and 
menus by typing on the computer�s keyboard. 

The calculator my be hiding the measurements in your sketch. If so, drag the 
calculator�s title bar to move the calculator to the side, so you can see both 
measurements. 
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You want to build an expression like this: 
BCentroid
CentroidF . (Your points may have different labels, but don�t 

worry about that.) 

• Click on the first measurement in the sketch, then on the division (slash) key on the keypad, and then 
on the second measurement in the sketch. 

• When the expression is as you want it in the top part of the Calculate dialog box, click OK.   

The ratio will be displayed in your sketch. 

Ready to make another conjecture? Don�t be hasty though. Better do some dragging to confirm it for all 
triangles.  As you drag parts of your triangle, the measured distances will change, but the ratio will remain 
a constant 2 (or 0.5 if you calculated the reciprocal). 

You can type your conjecture in the sketch itself, by adding a caption. 

• Choose the Text tool from the toolbox. 

• Press in an empty place in your sketch, and drag down and to the right to draw out a rectangle. 

• Use the keyboard to type your conjecture. The rectangle expands as needed to accommodate your 
typing. 

• Choose Text Style or Text Font from the Display menu to change the format of your text. 

• After you finish typing, you can use the Selection Arrow tool to drag your caption to a different place 
in the sketch. Or drag a corner of the caption to change its size. 

What can you say about those six little triangles formed by the three medians? 

• Select the three vertices of one of the little triangles. 

 
• Choose Polygon Inter  iior n the Construct menu. 

A shaded interior appears, striped to indicate that it�s selected.  While it�s 
selected, you can change its appearance using Color in the Display menu. 

 

• Construct the interior of another of the little triangles. Give it a different 
shade or color. 

• Select one of the triangle interiors by clicking on it (if it�s not already selected) and choose Area from 
the Measure menu. Now measure the area of the other triangle interior. (If measures are piling up in 
inconvenient places you can move them with the Selection Arrow tool, just like other objects.) 
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Surprised? It may be easy to prove that two small triangles whose 
bases are on the same side of the big triangle will have equal areas, 
but proving that all six triangles have equal areas is more of a 
challenge. (Confirm that all six do have equal areas, if you�re so 
inclined. And don�t forget to drag parts of the large triangle so that 
you can generalize for all triangles.) 

 

Tutorial III: Constructing a Rhombus 
With Sketchpad, you can use the Segment tool to construct a quadrilateral that looks like a rhombus by 
simply drawing four connected segments and dragging the vertices until it looks right. But that 
quadrilateral won�t stay a rhombus when you drag its vertices. Why? Because nothing in your drawing 
defines it as a rhombus. All you�ve told Sketchpad is to connect four segments at their endpoints. In this 
tutorial, you�ll construct a rhombus so that it remains a rhombus no matter how you drag it. 

The difference between a drawing and a construction is something students new to Sketchpad have 
difficulty with. They need to be made aware that if they�re studying properties of a rhombus, for example, 
they need to construct a rhombus with the necessary constraints, not just draw a quadrilateral that looks 
like a rhombus. Figuring out how to construct a figure with the necessary constraints helps reinforce for 
students the defining characteristics of that figure. 

Sketchpad comes with a booklet called Teaching Geometry with the Geometer�s Sketchpad which 
contains many sample activities. A separate volume called Exploring Geometry with The Geometer�s 
Sketchpad contains over 100 classroom activities. Some sample activities are also included later in this 
guide. In these sample activities, usually only point labels are shown. In this tutorial you�ll learn how to 
display point labels automatically. If you follow the steps in an activity exactly, your figure will match up 
with the figure shown in the activity. But if you undo something, your labels might no longer match those 
shown in the activity, and it could get confusing. Just remember, the parts and relationships in the figure 
are important�the labels are not. You probably don�t want to spend a lot of time relabeling your sketches 
to match the activities. You may even prefer not to show point labels in your sketch. 

Sample activities almost always begin with an introduction, followed by a section titled �Sketch.� The 
Sketch section gives all the steps for a construction. But unlike this tutorial, the steps given in an activity 
assume you know how to carry out those steps. Below you�ll see what the Sketch section of an activity 
looks like. Don�t attempt to follow these steps unless you know what you�re doing. Detailed instructions 
for each step follow in this tutorial. 

• Click Display in the menu bar and then click Preferences. You�ll see the dialog shown below right. 

 

MATH 6118 090 9 Spring 2002 



MATH 6118 090  Introduction to Geometer�s Sketchpad 

• Click the box to Autoshow Labels for Points. Click OK. Now you�re ready for the construction steps. 

Again, the steps you see in the following box are shown the way steps are shown in sample activities: 
they describe geometric constructions, but they don�t tell you exactly what to do with Sketchpad. You can 
try them now, or read on for more specific instructions. 

 
SKETCH 

Step 1: Construct AB. 

Step 2: Construct circle AB. 

Step 3: Construct AC, where C is any point on the 
circle.  

Step 4: Construct a line through C, parallel to AB. 

Step 5: Construct a line through B, parallel to AC. 

Step 6: Construct CD, where D is the intersection of the 
lines through B and C. 

Step 7: Hide the circle and the lines. 

Step 8: Construct BD. 

Now, here�s a detailed description of how to do each step. Start with a new sketch. 

Step 1: Construct AB. 

• Choose the Segment tool and press and drag to create a segment with endpoints A and B. 

Sketchpad has given this segment a label (probably j) but you�ve chosen not to 
display it. To keep things simple, the activities will name all objects after points that 
define them, so this segment will be referred to as AB. 

Step 2: Construct circle AB. 

• Choose the Circle tool. Move the pointer over point A, press, drag so the pointer is directly over point 
B, and release.   

Your circle is defined by two points: center A, where you pressed the mouse 
button, and radius point B, where you released. For this reason, we adopt an 
unusual convention in activities for naming Sketchpad circles. Instead of just 
naming them after their centers, we name circles after the two points that define 
them. (Sketchpad labels circles as c1, c2, and so forth.) 

Step 3: Construct AC, where C is any point on the circle. 

• Choose the Segment tool. Press on A and drag until the pointer is somewhere on the circle. Release to 
construct the segment�s endpoint C constrained to lie on the circle. 

Whenever you release directly over a straight object or circle with any 
construction tool, the point constructed will be constrained to lie on the straight 
object or circle. 
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Step 4: Construct a line through C, parallel to AB. 

• Click the Selection Arrow tool and select point C and segment AB. (Remember to hold down Shift to 
select both objects.) Choose Parallel Line in the Construct menu. 

Step 5: Construct a line through B, parallel to AC. 

• Select point B and segment AC. Choose Parallel Line in the Construct menu. 

Step 6: Construct CD, where D is the intersection of the lines through B and C. 

• In this step you�ll construct a segment over an existing line. Choose the Segment tool. Press on C and 
drag until the pointer is over the intersection of the two lines. Release to construct the segment�s 
endpoint D at the intersection. 

Whenever you release directly over an intersection of two objects with 
any construction tool, the point constructed will be the point of 
intersection.  You�ve constructed all the essentials for your rhombus. But 
your figure consists of more than just a rhombus�it includes all the 
objects that define its construction. You want to show only the rhombus. 
To do this, you�ll hide the circle and lines. They�ll still be there defining 
the geometry, you just won�t see them. 

Step 7: Hide the circle and the lines. 

• Select the circle. Choose Hide Circle in the Display menu. 

• Press the Segment tool and drag to choose the Line tool. Choose Select All Lines in the Edit menu. 

The Select All command changes depending on what tool you�re using. In this case it selected all the 
lines. If you�d chosen the Selection Arrow tool, this command would have selected all the objects in your 
sketch. 

• Choose Hide Lines in the Display menu. 

Your rhombus is just about complete now. 

 

Step 8: Construct BD. 

Congratulations. You now have a Sketchpad rhombus. Unlike a rhombus you might 
draw using only the Segment tool, this rhombus stays a rhombus when you manipulate it. 
See what happens when you drag any of its vertices. Why do you think dragging A, B, or 
C gives a different result than dragging D? See if you can drag a part of your rhombus so 

it appears square. 

You may want to measure some quantities in your rhombus to confirm that it is, in fact, a rhombus. 
Measurement will also help you explore some angle properties of a rhombus. Instructions to measure 
something in a sample activity may say simply �Measure AB.� In the activities, when we name a segment 
without a segment symbol, we�re referring to the length of the segment or the distance between the points. 
It can be measured in different ways. 

• First, select points A and C. (Remember to hold down Shift.) Choose Distance in the Measure menu. 
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Note that Distance and Coordinates are the only choices that are not grayed out. The Measure menu, 
like the Construct menu, requires appropriate selections to make the commands work. The 
measurement Sketchpad displays looks like this: AC = 2.10 inches. 

• Select segment BD. (Be sure to select the segment itself, and not its end points.) Click Measure in the 
menu bar and choose Length from the menu. 

Length and Slope are the only choices that are not grayed out. The measurement Sketchpad displays 
looks like this: m BD= 2.10 inches. 

Note that Sketchpad distinguishes between measuring the distance between two points. and measuring the 
length of a segment. 

• Now use the Text tool to display the label of segment AB. (The segment is probably labeled j.) Then 
select this segment and choose Length from the Measure menu. This time Sketchpad displays the 
measurement as j = 2.10 inches. 

Sketchpad displays the length of a segment differently, depending on whether the segment�s label is 
showing. 

The segment is named by its own label if the label is showing: j = 2.10 inches. If the label is not showing, 
the segment is named by its end points: m AB = 2.10 inches. 

You can change how the measurement is displayed. 

• Double-click on the measurement text for the length of segment j with the Text tool. 

The Format Measurement dialog appears. 

Measurements can be displayed in either math or text 
format. Math format usually looks better, but can�t easily 
be changed. 
 
 
 
 

• Click the text format radio button so you can change how the measurement appears. 

The dialog displays the measurement in text format. 

 
 
 
 
 
 
 

The text shown white on black is selected and can be replaced by typing. Or you can click in the edit box 
and edit the text. Change the text to read AB = . Click OK. 

To finish confirming that the figure is a rhombus, measure the remaining side length. 

What about the rhombus� angles? Let�s see if there is a relationship between angles. 

• Select, in order, points C, A, and B. Choose Angle in the Measure menu. 

To identify an angle to Sketchpad, you must select three points, with the vertex as the middle selection. 
(This is the same way most geometry books name angles using three points.) 
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• Measure other angles, including whatever you need to determine the relationship between angles in 
the rhombus. (The Calculate command may help you make these relationships clearer.) 

• Drag vertices of the rhombus, to change the size, shape, position and orientation of the rhombus. 
Make sure that the measured relationships between sides and between angles don�t change, even 
though the measurements themselves change. 

Now that your construction is finished, you can use Sketchpad�s scripting capability to describe the 
construction (even the hidden parts) in words, and then use the resulting script to replay the same 
construction in a different sketch. 

• Choose the Selection Arrow tool, and use it to draw a selection marquee and select your entire 
rhombus.  

Click in an empty area of the sketch above and to the side of your rhombus, and 
drag down and across so that the entire rhombus is within the resulting rectangle 
(or marquee). When you release the mouse button, everything in the marquee is 
selected. (If you start dragging in the wrong place, so you can�t surround the 
entire rhombus, you can just release the mouse button and start over in a better 
place.) 

• Choose Make Script in the Work menu. This creates a script that describes in words your entire 
rhombus construction. If the script window is too small to read all the steps, move the cursor to a 

corner or an edge of the window and drag to enlarge 
the window. 

It�s convenient to use a script to document a sketch. 
From a printed copy of the rhombus, you can�t determine 
whether the construction was done in such a way that the 
figure will always remain a rhombus. But if the printed 
sketch is accompanied by a printed copy of the script, 
the details of the construction are clear. (But remember 
that you can�t print either sketches or scripts with the 
demonstration version of Sketchpad.) 

• Inspect the script and compare it to the steps you 
followed as you did the construction. There are several things you should observe: 

1. The free points in your construction (that is, those which don�t depend on any other objects in the 
sketch) are listed as the Givens. 

2. Each step in the script constructs only a single object. Thus the step in which you constructed AC 
(Step 3 in the instructions above) is actually listed as two steps in the script: script step 3 
constructs point C on the circle, and script step 4 constructs the segment between A and C. 

3. The script shows all the objects used in the construction, even the ones that have been hidden. 

4. The order in which steps appear in the sketch may not be the same as the order in which you 
actually did the construction. (But the order of steps in the script is always a valid logical order 
which you could have used to construct the sketch.) 

Now create a new sketch window, and use your script to make a new rhombus. 

• Choose New Sketch from the File menu. A new sketch window opens. 

• Use the Point tool to construct a point in the sketch. Hold the shift key down while you construct a 
second point. Both points should be selected. (If you forgot to hold the shift key while you 
constructed the second point, choose Select All Points from the Edit menu to select both points.) 
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• Click the title bar of the script window to bring it to the front. Then click the PLAY button in the 
script window.  

The script plays in your new sketch window, using the two selected points as the Given objects. You can 
also use the STEP button in the script window to make the script play a single step at a time, or click 
FAST to play the script all at once, with no delay between steps. 

• Try different commands in the Construct menu. Can you figure out the selections required to make 
them work? (If you get stumped, use the Construction Help menu item.) 

• Answer the following questions: 

1. What can you construct if you have a segment selected? 
2. What do you need to select to enable the command Circle By Center And Radius? 
3. What do you need to select to construct an angle bisector? 
4. What can you construct if you have any combination of two segments, lines, rays, or circles? 
5. What can you construct if you have two points selected? Three points? Four or more points? 
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